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Toshiba CTX 670 SMDI Integration Guide for
Cisco Unity 4.0

Revised April 4, 2006

This document provides instructions for integrating the phone system with Cisco Unity.

Caution The AMIS Analog Networking feature is not available with the Toshiba CTX 670 integration. The
Toshiba CTX 670 phone system uses the “D” DTMF tone as the hang-up tone. The AMIS feature
requires the exclusive use of the “D” tone for its handshake routine.

Integration Tasks
Before doing the following tasks to integrate Cisco Unity with the Toshiba CTX 670 phone system
confirm that the Cisco Unity server is ready for the integration by completing the applicable tasks in
applicable Cisco Unity installation guide.

The following task lists describe the process for creating, changing, and deleting integrations.

Task List to Create the Integration
Use the following task list to set up a new integration with the Toshiba CTX 670 phone system. I
are installing a new Cisco Unity server by using the applicable Cisco Unity installation guide, you
have already completed some of the following tasks.

1. Review the system and equipment requirements to confirm that all phone system and Cisco
server requirements have been met. See the“Requirements” section on page 2.

2. Plan how the voice messaging ports will be used by Cisco Unity. See the“Planning How the Voice
Messaging Ports Will Be Used by Cisco Unity” section on page 4.

3. Program the Toshiba CTX 670 phone system and extensions. See the“Programming the Toshiba
CTX 670 Phone System” section on page 6.

4. Create the integration. See the“Creating a New Integration with the Toshiba CTX 670 Phone
System” section on page 7.
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5. Test the integration. See the“Testing the Integration” section on page 11.

6. If you have a secondary server for Cisco Unity failover, integrate the secondary server. See t
“Integrating a Secondary Server for Cisco Unity Failover” section on page 15.

Task List to Make Changes to an Integration
Use the following task list to make changes to an integration after it has been created.

1. Start the Cisco Unity Telephony Integration Manager (UTIM). See the“Changing the Settings for
an Existing Integration” section on page 18.

2. Make the changes you want to the existing integration. See the“Changing the Settings for an
Existing Integration” section on page 18.

Task List to Delete an Existing Integration
Use the following task list to remove an existing integration.

1. Start the Cisco Unity Telephony Integration Manager (UTIM). See the“Deleting an Existing
Integration” section on page 19.

2. Delete the existing integration. See the“Deleting an Existing Integration” section on page 19.

Requirements
The Toshiba CTX 670 integration supports configurations of the following components:

Phone System

• Toshiba CTX 670 phone system.

• CTX WinAdmin Application 1.13 or later.

• The serial data port in the phone system connected to a serial port (COM1 is the default) on
Cisco Unity server with an RS-232 serial cable.

We recommend that the serial cable have the following construction:

– A maximum of 50 feet (15.24 m) in length

– 24 AWG stranded conductors

– Low capacitance—for example, no more than 12 pF/ft (39.4 pF/m) between conductors

– At least 65 percent braided shield over aluminized polymer sleeve around conductors

– UL-recognized overall cable jacket insulation with low dielectric constant

– Braided shield fully terminated to and enclosed by a metal connector backshell

– Gold-plated connector contacts

• The voice messaging ports in the phone system connected to the voice cards in the Cisco U
server.

• The phone system ready for the integration as described in the installation guide for the pho
system.
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Cisco Unity Server

• The applicable voice cards, installed. For details, refer to the “Supported Circuit-Switched Ph
System Integrations” section in your version ofCisco Unity System Requirements at
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides_list.html.

• Cisco Unity installed and ready for the integration, as described in the applicable Cisco Unity
installation guide at
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides_list.html.

• A license that enables the applicable number of voice messaging ports.

• An available serial port (COM1 is the default).

Integration Description
The Toshiba CTX 670 integration uses a data link, which consists of an RS-232 serial cable conne
the phone system and the Cisco Unity server. The voice messaging lines from the phone system c
to the analog voice cards in the Cisco Unity server.Figure 1 shows the required connections.

Figure 1 Connections Between the Phone System and Cisco Unity

Call Information
The phone system sends the following information through the data link:

• The extension of the called party

• The extension of the calling party (for internal calls) or the phone number of the calling party (
is an external call and the system uses caller ID)

• The reason for the forward (the extension is busy, does not answer, or is set to forward all ca

Cisco Unity uses this information to answer the call appropriately. For example, a call forwarded
Cisco Unity is answered with the personal greeting of the subscriber. If the phone system routes th
to Cisco Unity without this information, Cisco Unity answers with the opening greeting.

Integration Functionality
The Toshiba CTX 670 integration with Cisco Unity provides the following integration features:

• Call forward to personal greeting

• Call forward to busy greeting

• Caller ID

RS-232 serial cable
Analog lines

Cisco Unity server
55

42
3

Phone system
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• Easy message access (a subscriber can retrieve messages without entering an ID because
Cisco Unity identifies the subscriber based on the extension from which the call originated; a
password may be required)

• Identified subscriber messaging (Cisco Unity identifies the subscriber who leaves a message d
a forwarded internal call, based on the extension from which the call originated)

• Message waiting indication (MWI)

Integrations with Multiple Phone Systems
Depending on the version, Cisco Unity can be integrated with two or more phone systems:

• Cisco Unity 4.0 and 4.1 can be integrated with a maximum of two phone systems at one time
information on and instructions for integrating Cisco Unity with two phone systems, refer to t
Dual Phone System Integration Guide at
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/integuid/multi/itmultin.htm.

• Cisco Unity 4.2 and later can be integrated with two or more phone systems at one time. For
information on the maximum supported combinations and instructions for integrating Cisco U
with multiple phone systems, refer to theMultiple Phone System Integration Guide at
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/integuid/multi/multcu42.htm.

Planning How the Voice Messaging Ports Will Be Used by
Cisco Unity

Before programming the phone system, you need to plan how the voice messaging ports will be us
Cisco Unity. The following considerations will affect the programming for the phone system (for
example, setting up the hunt group or call forwarding for the voice messaging ports):

• The number of voice messaging ports installed.

• The number of voice messaging ports that will answer calls.

• The number of voice messaging ports that will only dial out, for example, to send message
notification, to set message waiting indicators (MWIs), to make AMIS deliveries, and to make
telephone record and playback (TRAP) connections.

The following table describes the voice messaging port settings in Cisco Unity that can be set in U
and that are displayed as read-only text on the System > Ports page of the Cisco Unity Administ

Table 1 Settings for the Voice Messaging Ports

Field Considerations

Extension Enter the extension for the port as assigned on the phone system.

Enabled Check this check box to enable the port. The port is enabled during normal operation.

Uncheck this check box to disable the port. When the port is disabled, calls to the port ge
ringing tone but are not answered. Typically, the port is disabled only by the installer duri
testing.

Answer Calls Check this check box to designate the port for answering calls. These calls can be inco
calls from unidentified callers or from subscribers.
4
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The Number of Voice Messaging Ports to Install

The number of voice messaging ports to install depends on numerous factors, including:

• The number of calls Cisco Unity will answer when call traffic is at its peak.

• The expected length of each message that callers will record and that subscribers will listen 

• The number of subscribers.

• The number of ports that will be set to dial out only.

• The number of calls made for message notification.

• The number of MWIs that will be activated when call traffic is at its peak.

• The number of AMIS delivery calls.

• The number of TRAP connections needed when call traffic is at its peak. (TRAP connections
used by Cisco Unity web applications and e-mail clients to play back and record over the pho

• The number of calls that will use the automated attendant and call handlers when call traffic is
peak.

It is best to install only the number of voice messaging ports that are needed so that system resour
not allocated to unused ports.

The Number of Voice Messaging Ports That Will Answer Calls

The calls that the voice messaging ports answer can be incoming calls from unidentified callers or
subscribers. Typically, the voice messaging ports that answer calls are the busiest.

You can set voice messaging ports to both answer calls and to dial out (for example, to send me
notifications). However, when the voice messaging ports perform more than one function and are
active (for example, answering many calls), the other functions may be delayed until the voice
messaging port is free (for example, message notifications cannot be sent until there are fewer c

Message Notification Check this check box to designate the port for notifying subscribers of messages. As
Message Notification to the least busy ports.

Dialout MWI

(not used by serial or SMDI
integrations)

Check this check box to designate the port for turning MWIs on and off. Assign Dialout MW
to the least busy ports.

AMIS Delivery

(available with the AMIS
licensed feature only)

Check this check box to designate the port for making outbound AMIS calls to deliver voi
messages from Cisco Unity subscribers to users on another voice messaging system.
Cisco Unity supports the Audio Messaging Interchange Specification (AMIS) protocol,
which provides an analog mechanism for transferring voice messages between differen
voice messaging systems.

This setting affects outbound AMIS calls only. All ports are used for incoming AMIS cal

Because the transmission of outgoing AMIS messages may tie up voice ports for long
periods of time, you may want to adjust the schedule on the Network > AMIS > Schedu
page so that outgoing AMIS calls are placed during closed hours or at times when
Cisco Unity is not processing many calls.

TRAP Connection Check this check box so that subscribers can use the phone as a recording and playb
device in Cisco Unity web applications and e-mail clients. Assign TRAP Connection to t
least busy ports.

Table 1 Settings for the Voice Messaging Ports (continued)

Field Considerations
5
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answer). For best performance, dedicate certain voice messaging ports for only answering incom
calls, and dedicate other ports for only dialing out. Separating these port functions eliminates the
possibility of a collision, in which an incoming call arrives on a port at the same time that Cisco Un
takes the port off-hook to dial out.

The Number of Voice Messaging Ports That Will Only Dial Out, and Not Answer Calls

Ports that will only dial out and will not answer calls can do one or more of the following:

• Notify subscribers by phone, pager, or e-mail of messages that have arrived.

• Turn MWIs on and off for subscriber extensions.

• Make outbound AMIS calls to deliver voice messages from Cisco Unity subscribers to users 
another voice messaging system. (This action is available only with the AMIS licensed featur

• Make a TRAP connection so that subscribers can use the phone as a recording and playback
in Cisco Unity web applications and e-mail clients.

Typically, these voice messaging ports are the least busy ports.

Caution In programming the phone system, do not send calls to voice messaging ports in Cisco Unity that c
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice mess
port is set only to Dialout MWI, do not send calls to it.

Preparing for Programming the Phone System

Record your decisions about the voice messaging ports to guide you in programming the phone s

Caution The AMIS Analog Networking feature is not available with the Toshiba CTX 670 integration. The
Toshiba CTX 670 phone system uses the “D” DTMF tone as the hang-up tone. The AMIS feature
requires the exclusive use of the “D” tone for its handshake routine.

Programming the Toshiba CTX 670 Phone System
If you use programming options other than those supplied in the following procedure, the perform
of the integration may be affected.

Do the following procedure.

To Program the Toshiba CTX 670 Phone System

Step 1 On the Toshiba CTX 670 phone system, activate the SMDI port.

Step 2 In System Assignments, set Station Number Digit Length to10, whether caller ID is used or not.

Note This setting does not affect the extension length on the phones.

Step 3 Confirm that the phones assigned to the voice messaging ports are designated as voice messagin
on the phone system.
6
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Caution In programming the phone system, do not send calls to voice messaging ports in Cisco U
that cannot answer calls (voice messaging ports that are not set to Answer Calls). For exa
if a voice messaging port is set only to Dialout MWI, do not send calls to it.

Step 4 Program each subscriber phone to forward calls to the pilot number that is assigned to the voice
messaging ports, based on one of the Cisco Unity call transfer types shown inTable 2.

Note You can use alternate extensions to create multiple line appearances, enable easy message acc
cell phones, and simplify addressing messages to subscribers at different locations in Cisco Uni
Enabling alternate MWIs lets Cisco Unity turn MWIs on at more than one extension. For details, se
“Appendix: Using Alternate Extensions and MWIs” section on page 19.

Creating a New Integration with the Toshiba CTX 670 Phone
System

After ensuring that the Toshiba CTX 670 phone system and the Cisco Unity server are ready for 
integration, do the following procedures to set up the integration and to enter the port settings.

To Create an Integration

Step 1 If UTIM is not already open, on the Windows Start menu of the Cisco Unity server, clickPrograms >
Cisco Unity > Manage Integrations. UTIM appears.

Step 2 In the left pane of the UTIM window, clickCisco Unity Server.

Step 3 On the Integration menu of the UTIM window, clickNew. The Telephony Integration Setup Wizard
appears.

Step 4 On the Welcome page, click the applicable phone system type, depending on your version of
Cisco Unity:

• Cisco Unity 4.2 or later—Circuit-Switched via Voice Cards

• Cisco Unity 4.0 or 4.1—Circuit-Switched (Traditional PBX)

Step 5 Click Next.

Table 2 Call Transfer Types

Transfer Type Usage

Release transfer
(blind transfer)

Program the phone to forward calls to the pilot number when:

• The extension is busy

• The call is not answered

Supervised transfer Program the phone to forward calls to the pilot number only when 
call is not answered. Confirm that call forwarding is disabled when the
extension is busy.
7
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Step 6 On the Name the Phone System Integration page, accept the default name or enter the phone s
name to identify this integration, then clickNext.

Step 7 On the Select Integration Method page, clickSerial, then clickNext.

Step 8 On the Select Phone System Manufacturer page, click the following settings, then clickNext.

Step 9 On the Select Serial Integration Packet Settings page, enter the following settings, then clickNext.

Step 10 On the Select COM Port Settings page, enter the following settings, then clickNext.

Step 11 On the Set Number of Voice Messaging Ports page, enter the number of voice messaging ports 
Cisco Unity that you want to connect to the phone system, then clickNext.

This number cannot be more than the number of ports on the installed voice cards or the number of
set up on the phone system.

Step 12 If other integrations already exist, the Enter Trunk Access Code page appears. Enter the extra digi
Cisco Unity must use to transfer calls through the gateway to extensions on the other phone system
which it is integrated. Then clickNext.

Table 3 Settings for the Select Phone System Manufacturer Page

Field Setting

Manufacturer Toshiba

Model CTX 670

Software Version All

Configuration File <if you have made copies of the .ini configuration file, the name of the
configuration file that you want to use>

Table 4 Settings for the Select Serial Integration Packet Settings Page

Field Setting

Station Field Length <the station prefix plus the default extension length; accept the default set
of 10>

Default Extension
Length

<the default length of extensions on the phone system; accept the default 
click another setting>

Table 5 Settings for the Select COM Port Settings Page

Field Setting

COM Port <the communications port on the Cisco Unity server that will receive the c
information; typically, this setting is 1>

Baud Rate <the baud rate that the phone system uses>

Data Bits <the number of data bits that the phone system uses>

Stop Bits <the number of stop bits that the phone system uses>

Parity <the parity that the phone system uses>
8
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Step 13 (Cisco Unity 4.2 and later only)On the Reassign Subscribers page, any subscribers whose phone sy
integration has been deleted and who are not currently assigned to a phone system integration will a
in the list.

If no subscribers appear in the list, clickNext and continue toStep 14.

Otherwise, select the subscribers that you want to assign to this phone system integration and clickNext.
You can use the following selection controls for selecting subscribers.

Step 14 (Cisco Unity 4.2 and later only) On the Reassign Call Handlers page, any call handlers whose pho
system integration has been deleted and that are not currently assigned to a phone system integrat
appear in the list.

If no call handlers appear in the list, clickNext and continue toStep 15.

Otherwise, select the call handlers that you want to assign to this phone system integration and 
Next. You can use the following selection controls for selecting call handlers.

Step 15 On the Completing page, verify the settings you entered, then clickFinish.

Step 16 At the prompt to restart the Cisco Unity services, clickYes. The Cisco Unity services restart.

Alternatively, you can restart the Cisco Unity services in UTIM on the Tools menu by clickingRestart
Cisco Unity.

To Enter the Voice Messaging Port Settings for the Integration

Step 1 After the Cisco Unity services restart, on the View menu, clickRefresh.

Table 6 Selection Controls for the Reassign Subscribers Page

Selection Control Effect

Check All Checks the check boxes for all subscribers in the list.

Uncheck All Unchecks the check boxes for all subscribers in the list.

Toggle Selected For the subscribers highlighted in the list, toggles between checking and
unchecking the check boxes.

If some highlighted subscriber check boxes are checked and others are
unchecked, clicking this button will check all the check boxes. Clicking agai
will uncheck all the check boxes.

Table 7 Selection Controls for the Reassign Call Handlers Page

Selection Control Effect

Check All Checks the check boxes for all call handlers in the list.

Uncheck All Unchecks the check boxes for all call handlers in the list.

Toggle Selected For the call handlers highlighted in the list, toggles between checking an
unchecking the check boxes.

If some highlighted call handler check boxes are checked and others are
unchecked, clicking this button will check all the check boxes. Clicking agai
will uncheck all the check boxes.
9
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Step 2 In the left pane of the UTIM window, expand the phone system integration that you are creating.

Step 3 In the left pane, click the name of the phone system.

Step 4 In the right pane, click thePorts tab.

Step 5 Enter the settings shown inTable 8 for the voice messaging ports.

For best performance, use the first voice messaging ports for incoming calls and the last ports to dia
This helps minimize the possibility of a collision, in which an incoming call arrives on a port at the sa
time that Cisco Unity takes the port off-hook to dial out.

Caution In programming the phone system, do not send calls to voice messaging ports in Cisco U
that cannot answer calls (voice messaging ports that are not set to Answer Calls). For exa
if a voice messaging port is set only to Message Notification, do not send calls to it.

Step 6 Click Save.

Step 7 Exit UTIM.

Table 8 Settings for the Voice Messaging Ports

Field Considerations

Extension Enter the extension for the port as assigned on the phone system.

Enabled Check this check box to enable the port. The port is enabled during normal operation.

Uncheck this check box to disable the port. When the port is disabled, calls to the port ge
ringing tone but are not answered. Typically, the port is disabled only by the installer duri
testing.

Answer Calls Check this check box to designate the port for answering calls. These calls can be inco
calls from unidentified callers or from subscribers.

Message Notification Check this check box to designate the port for notifying subscribers of messages. As
Message Notification to the least busy ports.

Dialout MWI

(not used by serial or SMDI
integrations)

Check this check box to designate the port for turning MWIs on and off. Assign Dialout MW
to the least busy ports.

AMIS Delivery

(available with the AMIS
licensed feature only)

Check this check box to designate the port for making outbound AMIS calls to deliver voi
messages from Cisco Unity subscribers to users on another voice messaging system.
Cisco Unity supports the Audio Messaging Interchange Specification (AMIS) protocol,
which provides an analog mechanism for transferring voice messages between differen
voice messaging systems.

This setting affects outbound AMIS calls only. All ports are used for incoming AMIS cal

Because the transmission of outgoing AMIS messages may tie up voice ports for long
periods of time, you may want to adjust the schedule on the Network > AMIS > Schedu
page so that outgoing AMIS calls are placed during closed hours or at times when
Cisco Unity is not processing many calls.

TRAP Connection Check this check box so that subscribers can use the phone as a recording and playb
device in Cisco Unity web applications and e-mail clients. Assign TRAP Connection to th
least busy ports.
10
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If the phone system uses extension numbers that begin with zero (for example, 0123 or 09876), 
following procedure.

Note that after the procedure is done all extension numbers must have the same number of digits.
case, for example, 0123 and 1234 are both allowed, but 0123 and 234 are not allowed. The extensi
would be interpreted as 0234.

To Enable Extensions Beginning with Zero

Step 1 On the Windows Start menu, clickPrograms > Cisco Unity > Manage Integrations. UTIM appears.

Step 2 In the left pane of the UTIM window, click the phone system integration, and click theProperties node.

Step 3 In the right pane of the UTIM window, click theIntegration  tab.

Step 4 Note the name of the Switch.ini file that appears in the Configuration File field.

Step 5 Exit UTIM.

Step 6 On the Windows Start menu, clickPrograms > Accessories > Notepad. The Notepad window appears

Step 7 On the File menu, clickOpen.

Step 8 In the Open dialog box, browse to the \CommServer\IntLib directory, and double-click the name o
Switch.ini file you noted inStep 4.

Step 9 In the Configuration section of the file, insert the following line:

AllowZeroLeadingExtensions=1

If the line is already present in the Configuration section, confirm that the final digit is1.

Step 10 Save the file, and exit Notepad.

Step 11 For the settings to take effect, restart the Cisco Unity server.

Testing the Integration
To test whether Cisco Unity and the phone system are integrated correctly, do the following proce
in the order listed.

If any of the steps indicate a failure, refer to the following documentation as applicable:

• The installation guide for the phone system.

• Cisco Unity Troubleshooting Guide, available at
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_troubleshooting_guides_list..

• The setup information earlier in this guide.

To Set Up the Test Configuration

Step 1 Set up two test extensions (Phone 1 and Phone 2) on the same phone system that Cisco Unity is
connected to.

Step 2 Set Phone 1 to forward calls to the Cisco Unity pilot number when calls are not answered.
11
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Caution The phone system must forward calls to the Cisco Unity pilot number in no fewer than f
rings. Otherwise, the test may fail.

Step 3 In the Cisco Unity Administrator, create a test subscriber to use for testing by doing the applicab
substeps below.

If your message store is Microsoft Exchange, do the following:

a. In the Cisco Unity Administrator, go to theSubscribers > Subscribers > Profilepage.

b. Click theAdd icon.

c. SelectNew Exchange Subscriber.

d. On the Add Subscriber page, enter the applicable information.

e. Click Add.

If your message store is IBM Lotus Domino, do the following:

a. In the Cisco Unity Administrator, go to theSubscribers > Subscribers > Profilepage.

b. Click theAdd icon.

c. Click Notes.

d. In the Address Book list, confirm that the address book listed is the one that contains the user
that you want to import.

If the address book that you want to use is not listed, go to theSystem > Configuration >
Subscriber Address Books page and add a different address book.

e. In the Find Domino Person By list, indicate whether to search by short name, first name, or l
name.

f. Enter the applicable short name or name. You also can enter * to display a list of all users, or
one or more characters followed by * to narrow your search.

g. Click Find.

h. On the list of matches, click the name of the user to import.

i. On the Add Subscriber page, enter the applicable information.

j. Click Add.

Step 4 In the Extension field, enter the extension of Phone 1.

Step 5 In the Active Schedule field, clickAll Hours - All Days .

Step 6 Click theSave icon.

Step 7 In the navigation bar, clickCall Transfer  to go to the Subscribers > Subscribers > Call Transfer pag
for the test subscriber.

For more information on transfer settings, refer to the “Subscriber Template Call Transfer Setting
section in the Cisco Unity Administrator Help.

Step 8 Under Transfer Incoming Calls, clickYes, Ring Subscriber’s Extension, and confirm that the extension
number is for Phone 1.

Step 9 Under Transfer Type, clickRelease to Switch.

Step 10 Click theSave icon.

Step 11 In the navigation bar, clickMessages to go to the Subscribers > Subscribers > Messages page for t
test subscriber.
12
Toshiba CTX 670 SMDI Integration Guide for Cisco Unity 4.0

OL-4404-07

Download from Www.Somanuals.com. All Manuals Search And Download.



Toshiba CTX 670 SMDI Integration Guide for Cisco Unity 4.0
Testing the Integration

tside

ting

means

This

 to
at the
ich

state

and

means
d the

name
eans
Step 12 Under Message Waiting Indicators (MWIs), checkUse MWI for Message Notification.

Step 13 In the Extension field, enterx.

Step 14 Click theSave icon.

Step 15 Open the Status Monitor by doing one of the following:

• In Internet Explorer, go tohttp://<Cisco Unity server name>/web/sm.

• Double-click the desktop shortcut to the Status Monitor.

• In the status bar next to the clock, right-click the Cisco Unity tray icon and clickStatus Monitor.

To Test an External Call with Release Transfer

Step 1 From Phone 2, enter the access code necessary to get an outside line, then enter the number ou
callers use to dial directly to Cisco Unity.

Step 2 On the Status Monitor, note which port handles this call.

Step 3 When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening gree
means that the port is configured correctly.

Step 4 Confirm that Phone 1 rings and that you hear a ringback tone on Phone 2. Hearing a ringback tone
that Cisco Unity correctly released the call and transferred it to Phone 1.

Step 5 Leaving Phone 1 unanswered, confirm that the state of the port handling the call changes to “Idle.”
state means that release transfer is successful.

Step 6 Confirm that, after the number of rings that the phone system is set to wait, the call is forwarded
Cisco Unity and that you hear the greeting for the test subscriber. Hearing the greeting means th
phone system forwarded the unanswered call and the call-forward information to Cisco Unity, wh
correctly interpreted the information.

Step 7 On the Status Monitor, note which port handles this call.

Step 8 Leave a message for the test subscriber and hang up Phone 2.

Step 9 On the Status Monitor, confirm that the state of the port handling the call changes to “Idle.” This 
means that the port was successfully released when the call ended.

Step 10 Confirm that the MWI on Phone 1 is activated. The activated MWI means that the phone system 
Cisco Unity are successfully integrated for turning on MWIs.

To Test Listening to Messages

Step 1 From Phone 1, enter the internal pilot number for Cisco Unity.

Step 2 When asked for your password, enter the default password. Hearing the request for your password
that the phone system sent the necessary call information to Cisco Unity, which correctly interprete
information.

Step 3 Confirm that you hear the recorded voice name for the test subscriber (if you did not record a voice
for the test subscriber, you will hear the extension number for Phone 1). Hearing the voice name m
that Cisco Unity correctly identified the subscriber by the extension.

Step 4 When asked whether you want to listen to your message, press1.

Step 5 After listening to the message, press3 to delete the message.
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Step 6 Confirm that the MWI on Phone 1 is deactivated. The deactivated MWI means that the phone system
Cisco Unity are successfully integrated for turning off MWIs.

Step 7 Hang up Phone 1.

Step 8 On the Status Monitor, confirm that the state of the port handling the call changes to “Idle.” This 
means that the port was successfully released when the call ended.

To Set Up Supervised Transfer on Cisco Unity

Step 1 In the Cisco Unity Administrator, go to theSubscribers > Subscribers > Call Transfer page.

If the name of the test subscriber is not displayed, click theFind icon (the magnifying glass) in the title
bar, then clickFind, and select the name of the test subscriber in the list that appears.

For more information on transfer settings, refer to the “Subscriber Template Call Transfer Setting
section in the Cisco Unity Administrator Help.

Step 2 Under Transfer Type, clickSupervise Transfer.

Step 3 Set the Rings to Wait For field to3.

Step 4 Click theSave icon.

To Test Supervised Transfer

Step 1 From Phone 2, enter the access code necessary to get an outside line, then enter the number ou
callers use to dial directly to Cisco Unity.

Step 2 On the Status Monitor, note which port handles this call.

Step 3 When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening gree
means that the port is configured correctly.

Step 4 Confirm that Phone 1 rings and that you do not hear a ringback tone on Phone 2. Instead, you sh
hear the indication your phone system uses to mean that the call is on hold (for example, music or b

Step 5 Leaving Phone 1 unanswered, confirm that the state of the port handling the call remains “Busy.”
state and hearing an indication that you are on hold mean that Cisco Unity is supervising the tra

Step 6 Confirm that, after three rings, you hear the greeting for the test subscriber. Hearing the greeting m
that Cisco Unity successfully recalled the supervised-transfer call.

Step 7 During the greeting, hang up Phone 2.

Step 8 On the Status Monitor, confirm that the state of the port handling the call changes to “Idle.” This 
means that the port was successfully released when the call ended.

To Delete the Test Subscriber

Step 1 In the Cisco Unity Administrator, go to theSubscribers > Subscribers > Profile page.

If the name of the test subscriber is not displayed, click theFind icon (the magnifying glass) in the title
bar, then clickFind, and select the name of the test subscriber in the list that appears.

Step 2 In the title bar, click theDelete Subscriber icon (the X).
14
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Step 3 Click Delete.

Integrating a Secondary Server for Cisco Unity Failover
The Cisco Unity failover feature enables a secondary server to provide voice messaging services
the primary server becomes inactive. For information on installing a secondary server for failover,
to the applicable Cisco Unity installation guide, available at
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides_list.html.

For information on failover, refer to theCisco Unity Failover and Configuration Guide. The Domino
version of the guide is available at
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/fail/fail401/dom/index.htm. The
Exchange version of the guide is available at
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/fail/fail401/ex/index.htm.

Requirements
The following components are required to integrate a secondary server:

Phone System

• A serial data port for the data link.

• A data splitter unit to split the single data link into two serial cables.

• Two additional RS-232 serial cables (to be used with the serial cable from the integration of 
primary server). With the three serial cables, connect one from the data port in the phone syst
the data splitter unit; connect the second from the data splitter unit to the serial port on the prim
server; and connect the third from the data splitter unit to the serial port on the secondary se

Cisco Unity Server

• One secondary server for each primary server installed and ready for the integration, as des
in the applicable Cisco Unity installation guide and earlier in this integration guide.

• The applicable cable configuration for each analog voice messaging port to simultaneously co
the phone system to the corresponding ports on both the primary and the secondary servers
example, connect port 1 on the phone system with both port 1 on the primary server and por
the secondary server.

• A license that enables failover.

Integration Description
The phone system uses a data link to send call information to the primary and secondary server
data splitter unit splits the single serial cable into two serial cables, enabling the data link to conne
the primary and secondary servers. The analog voice messaging lines from the phone system pr
voice connectivity to the primary and secondary servers.Figure 2 shows the required connections.
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Figure 2 Connections Between the Phone System and Cisco Unity Servers

The primary and secondary servers act in the following manner:

• When the primary server is operating normally, the secondary server is inactive.

• When the primary server becomes inactive, the secondary server becomes active.

• When the primary server becomes active again, the secondary server becomes inactive.

Setting Up the Secondary Server for Failover
Do the following procedure to integrate the secondary server.

To Set Up the Secondary Server for Failover

Step 1 Install a secondary server with the same configuration as the primary server. For installation instruc
refer to the applicable Cisco Unity installation guide.

Step 2 Make all voice connections from the phone system to the corresponding ports on both the primary s
and the secondary server. For example, connect port 1 from the phone system with port 1 on bot
primary and the secondary servers.

Step 3 Connect one serial cable from the serial port on the phone system to the data splitter unit.

Step 4 Connect the remaining two serial cables to the two serial ports on the data splitter unit. Then con
one serial cable to the serial port on the primary server and the other serial cable to the serial port
secondary server.

Step 5 On the Windows Start menu of the secondary server, clickPrograms > Cisco Unity > Manage
Integrations. The UTIM window appears.

Step 6 On the Integration menu of the UTIM window, clickNew. The Telephony Integration Setup Wizard
appears.

Step 7 Enter the settings to match the integration settings on the primary server.

Note We recommend not reassigning any unassigned subscribers and call handlers to the new
integration, if you are asked by the wizard. Failover replication will automatically assign th
correct integration.

Step 8 At the prompt to restart the Cisco Unity services, clickYes.

69
25

8

Phone system

Data splitter

RS-232 serial cables
Analog lines

Primary
Cisco Unity server

Secondary
Cisco Unity server
16
Toshiba CTX 670 SMDI Integration Guide for Cisco Unity 4.0

OL-4404-07

Download from Www.Somanuals.com. All Manuals Search And Download.



Toshiba CTX 670 SMDI Integration Guide for Cisco Unity 4.0
Integrating a Secondary Server for Cisco Unity Failover

con

o the

,

n the

on

nity
mple,
Note When restarting the Cisco Unity services, use the UTIM prompt instead of the Cisco Unity i
in the Windows taskbar. The taskbar icon does not restart all of the Cisco Unity services.

Step 9 After Cisco Unity restarts, on the Windows Start menu of the Cisco Unity server, clickPrograms >
Cisco Unity > Manage Integrations. UTIM appears.

Step 10 In the left pane of the UTIM window, click the phone system integration that you created inStep 6.

Step 11 For Cisco Unity 4.0 and 4.1, continue toStep 12.

For Cisco Unity 4.2 and later, do the following substeps.

a. In the right pane, clickProperties.

b. On the Integration tab, compare the setting of the Integration ID field for the secondary server t
setting of the Integration ID field for the primary server.

c. If the integration IDs of the phone system on the primary and secondary server are the same
continue toStep 12.

If the integration IDs of the phone system on the primary and secondary servers are different, o
secondary server, clickModify Integration ID .

d. When cautioned that subscribers associated with the current Integration ID setting will not be
automatically associated with the new Integration ID setting, clickOK .

e. In the Modify Integration ID dialog box, in the Enter New Integration ID field, enter the Integrati
ID setting for the phone system on the primary server and clickOK .

f. Click Save.

g. At the prompt to restart the Cisco Unity services, clickNo.

h. In the left pane, click the phone system integration that you created inStep 6.

Step 12 In the right pane of the UTIM window, click thePorts tab.

Step 13 Enter the port settings to match the port settings on the primary server.

Caution In programming the phone system, do not send calls to voice messaging ports in Cisco U
that cannot answer calls (voice messaging ports that are not set to Answer Calls). For exa
if a voice messaging port is set only to Dialout MWI, do not send calls to it.

Step 14 Click Save.

Step 15 Exit UTIM.

Step 16 Click Programs > Cisco Unity > Edit Switch Utility.

Step 17 In the Switch Configuration Editor window, in the Manufacturer field, clickToshiba.

Step 18 In the Model field, clickCTX 670.

Step 19 Click Edit .

Step 20 In the Switch Configuration dialog box, click theIncoming Calls tab.

Step 21 In the Call Rings field, enter3 and clickOK .

Step 22 In the Switch Configuration Editor dialog box, clickExit .

Step 23 On the Windows Start menu, clickRun.

Step 24 EnterRegedit and clickOK .
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Caution Changing the wrong registry key or entering an incorrect value can cause the server to
malfunction. Before you edit the registry, confirm that you know how to restore it if a proble
occurs. (Refer to the “Restoring” topics in Registry Editor Help.) If you have any questio
about changing registry key settings, contact Cisco TAC.

Step 25 If you do not have a current backup of the registry, clickRegistry > Export Registry File, and save the
registry settings to a file.

Step 26 Expand the key HKEY_LOCAL_MACHINE\Software\Active Voice\Miu\1.0\Initialization.

Step 27 Double-clickNew Call Delay on Inactive Backup Server.

Step 28 In the Edit DWORD Value dialog box, in the Value Data field, enter0, and clickOK .

Step 29 Close the Registry Editor.

Step 30 Restart the Cisco Unity server.

No changes to the hunt group programming on the phone system are necessary.

Changing the Settings for an Existing Integration
After the integration is set up, if you want to change any of its settings (for example, to add or re
voice messaging ports for an integration), do the following procedure.

To Change the Settings for an Integration

Step 1 On the Cisco Unity server, on the Windows Start menu, clickPrograms > Cisco Unity > Manage
Integrations. The UTIM window appears.

Step 2 In the left pane, double-clickUnity Server. The existing integrations appear.

Step 3 Click the integration you want to modify.

Step 4 In the right pane, click the name of the cluster, phone system, or PIMG unit (depending on your
integration) for the integration.

Step 5 In the right pane, click the applicable tab for the integration.

Step 6 Enter new settings in the fields that you want to change.

Caution If you are adding or removing voice messaging ports, make sure you change the settin
the individual ports so that there are an appropriate number of ports set to answer calls a
appropriate number of ports set to dial out.

Step 7 In the UTIM window, clickSave.

Step 8 If prompted, restart the Cisco Unity services.
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Deleting an Existing Integration
If you want to delete an existing integration (for example, you have replaced the phone system w
which Cisco Unity originally integrated), do the following procedure.

To Delete an Existing Integration

Step 1 On the Cisco Unity server, on the Windows Start menu, clickPrograms > Cisco Unity > Manage
Integrations. The UTIM window appears.

Step 2 In the left pane, double-clickUnity Server. The existing integrations appear.

Step 3 Click the integration that you want to delete.

Step 4 On the Integration menu, clickDelete.

Step 5 Follow the on-screen instructions to assign the subscribers of the deleted phone system integrat
another phone system integration.

Step 6 At the prompt to restart the Cisco Unity services, clickYes. The Cisco Unity services restart.

Alternatively, you can restart the Cisco Unity services in UTIM on the Tools menu by clickingRestart
Cisco Unity.

Step 7 If the integration you deleted used voice cards, remove the voice cards from the Cisco Unity serv

Appendix: Using Alternate Extensions and MWIs

Alternate Extensions
In addition to the “primary” extension that you specify for subscribers, you can assign subscribers
nine alternate extensions. (The primary extension is the one that you assign to each subscriber wh
create his or her subscriber account; it is listed on the Subscribers > Subscribers > Profile page.

Reasons to Use Alternate Extensions

There are several reasons that you may want to specify alternate extensions for subscribers. For ex
if you have more than one Cisco Unity server that accesses a single, corporate-wide directory, you
want to use alternate extensions to simplify addressing messages to subscribers at the different loc
With alternate extensions, the number that a subscriber uses when addressing a message to som
another location can be the same number that the subscriber dials when calling. You may also w
use alternate extensions to:

• Handle multiple line appearances on subscriber phones.

• Offer easy message access on direct calls from a cell phone, home phone, or phone at an a
work site (assuming that the phone number is passed along to Cisco Unity from these other 
systems). In addition, when such phones are used as alternate extensions, and are set to forw
Cisco Unity, callers can listen to the subscriber greeting, and leave messages for the subscrib
as they would when dialing the primary extension for the subscriber.
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Tip To reduce the number of requests from subscribers who want alternate extensions set up
multiple cell phones, home phones, and other phones, give subscribers class of service (
rights to specify their own set of alternate extensions. (See the Subscribers > Class of Serv
Profile page.) With proper COS rights, a subscriber can specify up to five alternate extensio
the Cisco Unity Assistant—in addition to the nine that you can specify on the Subscribers
Alternate Extensions page in the Cisco Unity Administrator.

• Enable URL-based extensions in Cisco Unity for an integration with a SIP phone system.

How Alternate Extensions Work

Before you set up alternate extensions, review the following list for information on how alternate
extensions work:

• Alternate extensions cannot exceed 30 characters in length. By default, each administrator-de
alternate extension must be at least 3 characters in length, while subscriber-defined alternat
extensions must be at least 10 characters.

You can use the Advanced Settings tool in Tools Depot to specify a minimum extension length
the extensions entered in the Cisco Unity Administrator and the Cisco Unity Assistant. Refer to
Advanced Settings Tool Help for details on using the settings. Respectively, the settings are
Administration—Set the Minimum Length for Locations, and Administration—Set the Minimu
Length for Subscriber-Defined Alternate Extensions.

• You can control whether subscribers can use the Cisco Unity Assistant to view the alternate
extensions that you specify in the Cisco Unity Administrator. To do so, see the Subscribers > C
of Service > Profile page. The Subscriber-Defined Alternate Extension table displays the alte
extensions that the subscriber adds.

• Neither the Cisco Unity Administrator nor the Cisco Unity Assistant will accept an extension 
is already assigned to another subscriber (either as a primary or alternate extension), or to a
distribution list, call handler, directory handler, or interview handler. Cisco Unity verifies that ea
alternate extension is unique—up to the dialing domain level, if applicable—before allowing ei
an administrator or a subscriber to create it.

• All alternate extensions use the same transfer settings as the primary extension.

• In many cases, Cisco Unity can activate a message waiting indicator (MWI) for an alternate
extension. However, depending on the phones and phone systems involved, some additional
system programming may be required to set this up.

Setting Up Alternate Extensions
Do the applicable procedure to add, modify, or delete alternate extensions:

• To Add Administrator-Defined Alternate Extensions, page 20

• To Modify or Delete Alternate Extension(s), page 21

To Add Administrator-Defined Alternate Extensions

Step 1 In the Cisco Unity Administrator, go to anySubscribers > Alternate Extensions page.

Step 2 In the Administrator-Defined Alternate Extensions table, enter an extension in any row. When ente
characters in the Alternate Extensions table, consider the following:
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• You can enter an extension up to 30 characters in length. (SIP integrations can use up to 30
alphanumeric characters.)

• Each extension must be unique—up to the dialing domain level, if applicable.

• Enter digits 0 through 9. Do not use spaces, dashes, or parentheses.

• For SIP integrations, you can also enter a valid alias for a SIP URL. For example, if the URL
SIP:aabade@cisco.com, enter aabade. Do not use spaces.

• Rows are numbered as a convenience. You can enter alternate extensions in any order, and y
have blank rows.

Step 3 RepeatStep 2 as necessary.

Step 4 Click theSave icon. Alternate extensions are enabled for all rows in the table.

To Modify or Delete Alternate Extension(s)

Step 1 In the Cisco Unity Administrator, go to anySubscribers > Alternate Extensions page.

Step 2 Do any of the following:

• To modify an extension, change the extension in the Alternate Extensions table.

• To delete extensions, check the check boxes next to the alternate extensions that you want to

• To remove all alternate extensions listed in the table, clickSelect All.

Step 3 Click theSaveicon.

Step 4 RepeatStep 2 andStep 3 as necessary.

Note You can run the Cisco Unity Bulk Import wizard when you want to add alternate extensions for mult
subscribers at once. When you do, the Cisco Unity Bulk Import wizard appends the new alternat
extensions to the existing table of alternate extensions, beginning with the first blank row.

Alternate MWIs
You can set up Cisco Unity to activate alternate MWIs when you want a new message for a subs
to activate the MWIs at up to 10 extensions. For example, a message left at extension 1001 can a
the MWIs on extensions 1001 and 1002.

Cisco Unity uses MWIs to alert the subscriber to new voice messages. MWIs are not used to ind
new e-mail, fax, or return receipt messages.

Setting Up Alternate MWIs
Cisco Unity can activate alternate MWIs. Note that depending on the phones and phone systems
additional phone system programming may be necessary. Refer to the installation guide for the p
system.
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To enable alternate MWIs for extensions, do the following procedure for each subscriber who ne
alternate MWIs.

To Set Up Alternate MWIs for Extensions

Step 1 In the Cisco Unity Administrator, go to the applicableSubscribers > Subscribers > Messages page.

Step 2 Confirm that theUse MWI for Message Notification check box is checked.

Step 3 Click theAdd button located beneath the MWI Extensions table to add a row to the table. By defa
the first row in the table contains an “X” to indicate the primary extension assigned to a subscribe
you want one more extension and do not need to activate the MWI on the primary extension, you
also modify the first row.

Step 4 Enter the applicable extension in theExtension field of the table. MWIs are automatically enabled fo
all rows in the table. When entering characters in the MWI Extensions table, consider the followi

• Enter digits 0 through 9. Do not use spaces, dashes, or parentheses.

• Enter , (comma) to insert a one-second pause.

• Enter # and * to correspond to the # and * keys on the phone.

Step 5 Click theSave icon.

Step 6 RepeatStep 3 throughStep 5 as necessary.

Note You can run the Cisco Unity Bulk Import wizard when you want to set up alternate MWIs for multip
subscribers at once.

To change or delete alternate MWIs for extensions, do the following procedure.

To Modify or Delete Alternate MWIs

Step 1 In the Cisco Unity Administrator, go to the applicableSubscribers > Subscribers > Messages page.

Step 2 Do either of the following:

• To modify an extension, change the extension in the MWI Extensions table.

• To delete extensions, check the check boxes next to the rows that you want to delete in the M
Extensions table, and then click theDelete button.

Step 3 Click theSave icon.

Step 4 RepeatStep 2 andStep 3 as necessary.
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Appendix: Documentation and Technical
Assistance

Conventions
TheToshiba CTX 670 SMDI Integration Guide for Cisco Unity 4.0 uses the following conventions.

TheToshiba CTX 670 SMDI Integration Guide for Cisco Unity 4.0also uses the following conventions

Note Meansreader take note. Notes contain helpful suggestions or references to material not covered in
document.

Table 9 Toshiba CTX 670 SMDI Integration Guide for Cisco Unity 4.0 Conventions

Convention Description

boldfaced text Boldfaced text is used for:

• Key and button names. (Example: ClickOK. )

• Information that you enter. (Example: EnterAdministrator  in the User
Name box.)

< >

(angle brackets)

Angle brackets are used around parameters for which you supply a value.
(Example: In the Command Prompt window, enter ping <IP address>.)

-

(hyphen)

Hyphens separate keys that must be pressed simultaneously. (Example: Pre
Ctrl-Alt-Delete.)

>

(right angle
bracket)

A right angle bracket is used to separate selections that you make:

• On menus. (Example: On the Windows Start menu, clickSettings > Control
Panel > Phone and Modem Options.)

• In the navigation bar of the Cisco Unity Administrator. (Example: Go to the
System > Configuration > Settings page.)

[x]

(square brackets)

Square brackets enclose an optional element (keyword or argument). (Examp
[reg-e164])

[x | y]

(vertical line)

Square brackets enclosing keywords or arguments separated by a vertical li
indicate an optional choice. (Example: [transport tcp | transport udp])

{x | y}

(braces)

Braces enclosing keywords or arguments separated by a vertical line indica
required choice. (Example: {tcp | udp})
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Caution Meansreader be careful. In this situation, you might do something that could result in equipment
damage or loss of data.

For descriptions and URLs of Cisco Unity documentation on Cisco.com, see theAbout Cisco Unity
Documentation. The document is shipped with Cisco Unity and is available at
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/about/aboutdoc.htm.

Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. Cisco also provides s
ways to obtain technical assistance and other technical resources. These sections explain how to
technical information from Cisco Systems.

Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/techsupport

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Product Documentation DVD
The Product Documentation DVD is a comprehensive library of technical product documentation
portable medium. The DVD enables you to access multiple versions of installation, configuration
command guides for Cisco hardware and software products. With the DVD, you have access to the
HTML documentation that is found on the Cisco website without being connected to the Internet
Certain products also have .PDF versions of the documentation available.

The Product Documentation DVD is available as a single unit or as a subscription. Registered Cisco
users (Cisco direct customers) can order a Product Documentation DVD (product number
DOC-DOCDVD= or DOC-DOCDVD=SUB) from Cisco Marketplace at this URL:

http://www.cisco.com/go/marketplace/

Ordering Documentation
Registered Cisco.com users may order Cisco documentation at the Product Documentation Store
Cisco Marketplace at this URL:

http://www.cisco.com/go/marketplace/
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Nonregistered Cisco.com users can order technical documentation from 8:00 a.m. to 5:00 p.m.
(0800 to 1700) PDT by calling 1 866 463-3487 in the United States and Canada, or elsewhere b
calling 011 408 519-5055. You can also order documentation by e-mail at
tech-doc-store-mkpl@external.cisco.comor by fax at 1 408 519-5001 in the United States and Canad
or elsewhere at 011 408 519-5001.

Documentation Feedback
You can rate and provide feedback about Cisco technical documents by completing the online fee
form that appears with the technical documents on Cisco.com.

You can submit comments about Cisco documentation by using the response card (if present) beh
front cover of your document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Cisco Product Security Overview
Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html

From this site, you will find information about how to:

• Report security vulnerabilities in Cisco products.

• Obtain assistance with security incidents that involve Cisco products.

• Register to receive security information from Cisco.

A current list of security advisories, security notices, and security responses for Cisco products i
available at this URL:

http://www.cisco.com/go/psirt

To see security advisories, security notices, and security responses as they are updated in real tim
can subscribe to the Product Security Incident Response Team Really Simple Syndication (PSIRT
feed. Information about how to subscribe to the PSIRT RSS feed is found at this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html

Reporting Security Problems in Cisco Products
Cisco is committed to delivering secure products. We test our products internally before we release
and we strive to correct all vulnerabilities quickly. If you think that you have identified a vulnerabi
in a Cisco product, contact PSIRT:

• For Emergencies only—security-alert@cisco.com

An emergency is either a condition in which a system is under active attack or a condition for w
a severe and urgent security vulnerability should be reported. All other conditions are consid
nonemergencies.
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• For Nonemergencies—psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:

• 1 877 228-7302

• 1 408 525-6532

Tip We encourage you to use Pretty Good Privacy (PGP) or a compatible product (for example, GnuP
encrypt any sensitive information that you send to Cisco. PSIRT can work with information that has
encrypted with PGP versions 2.x through 9.x.

Never use a revoked or an expired encryption key. The correct public key to use in your correspond
with PSIRT is the one linked in the Contact Summary section of the Security Vulnerability Policy p
at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html

The link on this page has the current PGP key ID in use.

If you do not have or use PGP, contact PSIRT at the aforementioned e-mail addresses or phone nu
before sending any sensitive material to find other means of encrypting the data.

Obtaining Technical Assistance
Cisco Technical Support provides 24-hour-a-day award-winning technical assistance. The Cisco
Technical Support & Documentation website on Cisco.com features extensive online support reso
In addition, if you have a valid Cisco service contract, Cisco Technical Assistance Center (TAC)
engineers provide telephone support. If you do not have a valid Cisco service contract, contact y
reseller.

Cisco Technical Support & Documentation Website
The Cisco Technical Support & Documentation website provides online documents and tools for
troubleshooting and resolving technical issues with Cisco products and technologies. The websi
available 24 hours a day, at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support & Documentation website requires a Cisco.com
ID and password. If you have a valid service contract but do not have a user ID or password, you
register at this URL:

http://tools.cisco.com/RPF/register/register.do

Note Use the Cisco Product Identification (CPI) tool to locate your product serial number before subm
a web or phone request for service. You can access the CPI tool from the Cisco Technical Suppo
Documentation website by clicking theTools & Resourceslink under Documentation & Tools. Choose
Cisco Product Identification Tool from the Alphabetical Index drop-down list, or click theCisco
Product Identification Tool  link under Alerts & RMAs. The CPI tool offers three search options: b
product ID or model name; by tree view; or for certain products, by copying and pastingshowcommand
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output. Search results show an illustration of your product with the serial number label location
highlighted. Locate the serial number label on your product and record the information before plac
service call.

Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service reques
and S4 service requests are those in which your network is minimally impaired or for which you req
product information.) After you describe your situation, the TAC Service Request Tool provides
recommended solutions. If your issue is not resolved using the recommended resources, your se
request is assigned to a Cisco engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests, or if you do not have Internet access, contact the Cisco TAC by telep
(S1 or S2 service requests are those in which your production network is down or severely degra
Cisco engineers are assigned immediately to S1 and S2 service requests to help keep your busi
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1 800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has established sev
definitions.

Severity 1 (S1)—An existing network is down, or there is a critical impact to your business operati
You and Cisco will commit all necessary resources around the clock to resolve the situation.

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of
business operations are negatively affected by inadequate performance of Cisco products. You and
will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of the network is impaired, while most business opera
remain functional. You and Cisco will commit resources during normal business hours to restore se
to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation
configuration. There is little or no effect on your business operations.
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Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is available from various o
and printed sources.

• TheCisco Product Quick Reference Guide is a handy, compact reference tool that includes brief
product overviews, key features, sample part numbers, and abbreviated technical specificatio
many Cisco products that are sold through channel partners. It is updated twice a year and inc
the latest Cisco offerings. To order and find out more about the Cisco Product Quick Referen
Guide, go to this URL:

http://www.cisco.com/go/guide

• Cisco Marketplace provides a variety of Cisco books, reference guides, documentation, and 
merchandise. Visit Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

• Cisco Presspublishes a wide range of general networking, training and certification titles. Both n
and experienced users will benefit from these publications. For current Cisco Press titles and
information, go to Cisco Press at this URL:

http://www.ciscopress.com

• Packet magazine is the Cisco Systems technical user magazine for maximizing Internet and
networking investments. Each quarter, Packet delivers coverage of the latest industry trends
technology breakthroughs, and Cisco products and solutions, as well as network deploymen
troubleshooting tips, configuration examples, customer case studies, certification and training
information, and links to scores of in-depth online resources. You can access Packet magazi
this URL:

http://www.cisco.com/packet

• iQ Magazineis the quarterly publication from Cisco Systems designed to help growing compan
learn how they can use technology to increase revenue, streamline their business, and expa
services. The publication identifies the challenges facing these companies and the technolog
help solve them, using real-world case studies and business strategies to help readers make
technology investment decisions. You can access iQ Magazine at this URL:

http://www.cisco.com/go/iqmagazine

or view the digital edition at this URL:

http://ciscoiq.texterity.com/ciscoiq/sample/

• Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering
professionals involved in designing, developing, and operating public and private internets an
intranets. You can access the Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

• Networking products offered by Cisco Systems, as well as customer support services, can b
obtained at this URL:

http://www.cisco.com/en/US/products/index.html

• Networking Professionals Connection is an interactive website for networking professionals t
share questions, suggestions, and information about networking products and technologies w
Cisco experts and other networking professionals. Join a discussion at this URL:

http://www.cisco.com/discuss/networking
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• World-class networking training is available from Cisco. You can view current offerings at
this URL:

http://www.cisco.com/en/US/learning/index.html

Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any examples, command display output, and
figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses in illustrative content is unintentiod
coincidental.

© 2006 Cisco Systems, Inc. All rights reserved.

Live, Play, and Learn, and iQuick Study are service marks of Cisco Systems, Inc.; and Access Registrar, Aironet, BPX, Catalyst, CCDA, CCDP, 
CCIE, CCIP, CCNA, CCNP, Cisco, the Cisco Certified Internetwork Expert logo, Cisco IOS, Cisco Press, Cisco Systems, Cisco Systems Capital, 
the Cisco Systems logo, Cisco Unity, Enterprise/Solver, EtherChannel, EtherFast, EtherSwitch, Fast Step, FormShare, GigaDrive, GigaStack, HomeLink, 
Internet Quotient, IOS, IP/TV, iQ Expertise, the iQ logo, iQ Net Readiness Scorecard, LightStream, Linksys, MeetingPlace, MGX, the Networkers logo, 
Networking Academy, Network Registrar, Packet, PIX, Post-Routing, Pre-Routing, ProConnect, RateMUX, ScriptShare, SlideCast, SMARTnet, 
The Fastest Way to Increase Your Internet Quotient, and TransPath are registered trademarks of Cisco Systems, Inc. and/or its affiliates in the 
United States and certain other countries. 
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